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Thank you for purchasing Integra for Notes, the solution designed to enable the highest degree of bi-directional
integration between Lotus Notes™ and Microsoft Word™ and Microsoft Excel ™ and output to XML and Adobe’s
PDF format™ or Integra Quick Reports, the solution which allows end-users of Lotus Notes to create and generate
ad-hoc reports to Microsoft Excel and mail merges and labels to Microsoft Word.

This Installation Manual is designed to allow people who are installing, deploying and configuring Integra for Notes
and/or Integra Quick Reports to understand the steps necessary for a successful installation and deployment and
the optimization of these products within their organization. The installation manual should be read in conjunction
with the following manuals:

Integra for Notes End-User Manual.
Integra Upgrade Manual (for existing users)
Integra for Notes Designer’s Manual

Integra Quick Reports user Manual

These materials are copyrighted and the intellectual property rights are vested in Shireburn Software Ltd. Copying
through any means is unauthorized without the express written permission of an officer of Shireburn Software Ltd.

Every reasonable attempt has been made to ensure the accuracy of this Installation Manual and that it reflects the
operations of the product, however users of Integra for Notes are responsible for ensuring that the product and its
documentation are suitable for the needs of that organization. No warranties explicate or otherwise in respect of

this Installation Manual are being made or can be assumed.

The product Integra for Notes may at times be referred to within this documentation by its shortened name of
Integra. This is not to be confused with any trademarked product of a similar name, whose rights are hereby
recognized and this abbreviation is used only for ease of reference.

SHIREBURN

Carolina Court, Guze Cali Street
Ta’ Xbiex, XBX 1425, Malta
Tel US (508) 915 4805 or (650) 276 0506

Tel UK (020) 7193 1296

Tel EU (+356) 2131 9977
Fax (+356) 2131 9528
info@shireburn.com
www.shireburn.com

www.integradnotes.com

Lotus, Lotus Notes, Domino and their respective logos as well as the IBM Business Partner logo are all registered trademarks of IBM Corporation. Microsoft,
Windows, Word, Excel and Internet Explorer as well as their respective logos are all trademarks of Microsoft Corporation. Acrobat Writer, Acrobat Distiller and PDF
are registered trademarks of Adobe Corp. All other trademarks are hereby duly acknowledged as the property of their respective owners.
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Introduction to this Manual

This Integra Installation & Configuration manual is designed to assist you in installing, configuring and deploying
Integra for Notes for Notes and Integra Quick Reports within your organization. The manual provides a step-by-
step explanation of all that is required to successfully deploy these products. Following these instructions correctly
will ensure a smooth implementation of Integra for Notes.

All the functionality required to run Integra for Notes and/or Integra Quick Reports is available within the Integra
database itself. No EXE or DLL files are required to be installed on any servers or workstations. The only change
required on user workstations is the deployment of the Integra Smarticon, which process is itself also automated.

Integra does not require any changes to be made to existing Lotus Notes databases that are to act as the source of
data for Integra reports, exports or imports except where web browser access is required. This means that no
design changes or inheritance is required and therefore no regression testing or updating of documentation is
required and the security of your applications is not effected.

1.1

Conventions used in this Manual

This Installation Manual is designed to be a guide to
the installation and deployment of Integra for Notes.
The keys required to be selected by a user are
explained within this manual by the use of angled CoCERCINE: Passport Enrolment Form
brackets. Therefore, an instruction to select the key Run on: @ Clent € Server
called Enter will appear as follows: select <Enter> Integra Action: [hebae =]
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MNotes Action: ¥ Mone
Prompts given to the user to allow selection of one Open | Save As PDF:

or more options are shown in a dialog box as
Protection: Mone =
follows:
Password: ‘ |

Hot tips of particular interest to readers are
displayed as follows:

If your profile has had its confidentiality restricted, only those users mentioned
in the profile’s confidentiality field will be able to see the profile.

Bright ideas are shown within the following type of display:

F o To create a profile document linking to a particular database, the user
" does not require Designer rights in the Access Control List of the
H database to which the link is being implemented but rather just Reader
level rights.

Integra — Installation & Configuration Manual - V4.7/1.0 1
Shireburn Software Ltd - © 2008/9 5" January 2009
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2 Introduction to Installing Integra

Integra is shipped to you as an installation executable (Integra.exe) which, when run, will allow a controlled
deployment of an Integra template and the user documentation to your local workstation. There are no
executables or DLL’s contained within this installer. From this template you can create your own Integra database
which can then be configured in accordance with the instructions in this manual.

The step-by-step installation and configuration process is summarized below and then further defined in detail
within the subsequent sections of this document. This procedure assumes that you have downloaded the
Integra.EXE file containing the installation & set up routine. The installation process for Integra involves the
following steps:

Run the Integra Setup Program (Integra.exe) to extract the Integra.ntf template to your local workstation.

2. Create a new Integra Lotus Notes database from the locally stored Integra template. We assume within this
manual that this database will be called Integra.NSF however it can be called whatever valid name is suitable
for you.

3. Sign the template with an ID file which has rights within your domain to execute 3" party software products
(thus avoiding ECL warnings being given to users unnecessarily) and, if you intend using Integra for Notes’
scheduled execution facilities, this ID must have the rights to execute restricted LotusScript agents on the
server(s) that Integra is deployed on.

4. Set the Access Control List of the Integra database according to the instructions detailed herein.

5. Enter your license key(s) into the Integra database

6. Optionally pre-allocate user licenses to the intended users of the software

7. Configure PDF Output (optional — only required if generating PDF based reports on a scheduled basis)

8. Enable scheduled running through the Configuration document (optional & only for Windows servers)

9. Enable the Integra database for web browser access (optional — only required if deploying Integra to web
users)

10. Install Word, Excel and PDF capability on Domino Server (optional only for Scheduled/ profiles)

11. Deploy the Integra database (.NSF) to your server(s)

12. Deploy the Integra Smartlcon to licensed users

13. Create an Integra Log Database (optional)

Integra — Installation & Configuration Manual —V4.7/1.0 2
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3 Step-by-Step Installation

This section of the Integra Installation & Configuration Manual will provide a step-by-step explanation of installing
Integra for Notes 4.7 in your environment.

3.1 Installing Integra Set-Up

You would have received the Integra for Notes software as a set up program (Integra.exe) either via e-mail, a
download or on CD. Save this file to a working directory of your choice from which the installation will be
executed. This is a working directory from which you will then be able to remove Integra.exe after its successful
install. The Integra.exe file contains

Integra template (Integra.NTF) — from which you will be able to create your own Integra database.

Links to Documentation — web links to the Integra End-User Manual, the Integra Profile Creator’s Manual, the
Integra Installation & Configuration Manual and the Integra Upgrade Manual all in PDF format. These files are
available at www.integra4notes.com/manuals.

Run the Integra.exe file either through the Windows Start->Run option or alternatively by double clicking on it
through Windows Explorer ™.

On running Integra.exe, you will see a small splash screen following which the Integra Installer Wizard commences
with the following screen:

Integrn for Hobes 45 e o Sl o B S )

= ra |
Ointegr |
Wulcume o the mslallabon wezand of Integia lor Holes and Infegra Uk Heporls

they drg lin Mok i Hisch Hepots orlo o

PIF suppor
Label wizard
Foernuln Builder

Lookup Wizeed
S it Blileor
In-Place Editing
and wch more

Tnstarlls l T T ] —

Tnsegra for Notes 45

On selecting the Next option, you will be shown the
software license agreement and given the opportunity to
agree or disagree with the terms of the agreement.

- e . . o Ointegr S
Disagreeing with the terms will result in you exiting from » ke Nt Lo e e
i X ) A i e,
the install process while agreeing will proceed to the next et g e g e PO A e i e
Carehidy 1o ralakg e & 5 boducts. By
stage. Pttty v

by ol the tairma of thit soreemant.

11 yous s ook g -y of the lesms: and
et &

e apeement, you
this and hak the installotion and ue of fhis product
wivnedately. By ol doveg 50, o ave el scceplng hese cordions

Evaustors # you we g . then,
softwars only for evahustion puposes snd only unt the date of anpry of the evaluston kcense -

Installs gk [ peean Qacien |
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Assuming that you proceed, the dialog box to select the directories will be presented to you.
Two sets of files will be installed during this process:

The Integra.ntf template - as with all Notes templates, this file is required to be stored in the Notes default
data directory. The Installer reads your registry settings to determine the default Notes data directory of your
installation and this is displayed in the dialog box. The option to change this exists using Browse although this
is not recommended. If you have multiple versions of Lotus Notes installed on your machine, Integra may not
be able to select the correct default data directory.

Links to the documentation files — links to the End-User Manual, the Installation & Configuration Manual and
the Upgrading to Integra Manual. These files are available at:

www.integra4notes.com/manuals

[r—ry e ===

The Integra Installer will provide you with a choice of locations
where to deploy the Integra template file contained in the installer.
The default for the template is the Notes default data directory of
your local workstation. The installation process will be read the path
from your system unless you have multiple versions of Lotus Notes
installed). Please ensure that you select the default data directory of
your local machine as the place to deploy the template. The
documentation links defaults to c:\Program Files\Integra for Notes 4.
While both directories for these files can be modified by the user
selecting the Browse button, this is not recommended for the Py
template. Deciding to install the links to documentation files in :
another directory is fine.

By proceeding further you can then select the Program Group that
the documentation files will be created in. This allows selection of
the files from the Windows Start->Program Files menu. The default
Group name is Integra for Notes 4. The current list of the user’s
groups are displayed.

Having selected the group the user is given one final opportunity to
confirm. On confirmation you will see a number of progress bars
while the files are copied to the chosen directories following which a conclusion screen is presented.

Integea for Notes 45 [=%=) Integra for Notes 45 — e

The Integra nstallation wizsd is complet

Sehup has frichesd rutaling Intoges o

@integra ©Ojaagr2

ion Fath c
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Files 10 b Instalied:
et s Nides T gt [Indegr s rll)
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Label wizaed
Formuls Builder

PIF supparnt
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Formuls Buikder
Lockup Wizard
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In-Place Editing
and mauch more
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i
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3.2 Create the Integra Database

Use Lotus Notes’ standard File 2Database 2New menu option to create | Newapplication B3]
a new database. Select the IntegradNotes template from the Local Specify New Application Name and Location
machine as the source of the design for the new database. The Integra Sever [Locd sl ok ]
. Title Integra
template is called Integra 4.7 Template. e e [ coned |
File name ‘Intagla nsf g
3 Encryption...
The newly created database can be created either on your local T otar d ot fios Tt T p—
machine or directly on the server assuming that you have the rights to Specify Template for New Application
create new databases on the server. Sever  [Local &
Template m Discussion - Notes & Web (8.5) -
This database can be given any file name you wish. In this manual, we i m
have assumed that the file is called Integra.nsf BB Mai (RE5) _
[ Microsoft Office Library (8) -
File name {\nlegmd?.nﬂ About...
[~ Show advanced templates
¥ Inherit future design changes

o As described above, the Integra installer unwraps a Notes template file
i i.e. a .NTFfile. Itis essential than a .NSF file is created from this template
“ and used to create Integra profiles and run reports.

Using a template file as the main database to create and run reports will
result in incorrect operation of Integra.

3.3 Sign the Integra Database

So as to ensure the smooth operation of Integra for Notes within your environment, and particularly to
avoid end-users being presented with Execution Control List (ECL) warnings, it is important that the
Integra database is correctly signed using an ID file authorized for operation in your environment, and for which
end-users are already certified for access. This will avoid end-users being presented with ECL warnings when
running Integra.

Check with your Domino administrator to confirm this step in the process if you are not familiar with this.

Should you intend using the scheduled facilities of Integra, or to deploy Integra to web browser access, then the ID
should also be authorized to execute restricted agents on the server(s) on which Integra is deployed.

In addition, since one of the agents deletes documents in the Integra database, this ID must also have deletion
rights in the ACL of the Integra database.

3.4 Set Security Options

The security settings required to run Integra include both ACL settings of the Integra database itself and execution
control settings on the server document.

Administrators who will be able to configure the Integra database need access to the [Admin] role to enable
configuration. We would recommend that administrators are granted a minimum of Editor rights and allocated
the [Admin] role. This should be implemented as a first step as configuration of certain other options are not
possible without this role.

Integra — Installation & Configuration Manual - V4.7/1.0 5
Shireburn Software Ltd - © 2008/9 5" January 2009
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End-Users who need to run Integra for Notes profiles need to be granted Author rights to the Integra database and
both the Create Documents and the Create Personal Folders/Views options must be enabled (ticked).

An insufficient level of rights will result in a warning being displayed to the user. Despite having Author rights,
users will still not be able to create Integra profiles as an [Import] role and an [Export] role govern the capability to
create Import and Export profiles respectively.

Users who are to be able to create profiles should be given access to the [Import] and/or [Export] role. See more
details below providing a full explanation of the available roles.

Summary of ACL Roles in Integra database

Description
Admin As described above, the Integra database contains an [Admin] role. Certain functionality in
Integra is restricted only to users and/or groups who have been granted this role. The
functions restricted to members of the [Admin] role are:
The ability to access the Configuration document through the Integra navigator and
through this feature most of the configuration options for Integra including:

the ability to access the Smartlcons view (see next section) and therefore the ability
to deploy or retract the Smartlcons from users.

The ability to access the Buttons view and therefore the ability to create and
maintain Button sets.

The setting of the Integra log database

Enablement of scheduled profiles

Import Users to be granted the ability to create Integra profiles to be used for the importation of
data into Notes databases need to be granted the Import role.

Export Users to be granted the ability to create Integra profiles to be used for the exporting of
data from Notes databases need to be granted the Export role.

Advanced Users requiring to see and amend the contents of the Advanced tab in an Integra profile
are to be granted access to the Advanced role.

Scheduled Users requiring to see and amend the contents of the Scheduled tab in an Integra profile
are to be granted access to the Scheduled role.

HiddenDesign A creator of an Integra profile is able to set a profile to operate directly from a specific

view. By selecting the All Documents in View option in the Notes tab, the profile creator is
presented with a set of the available views in the database.

This list will not display hidden views unless the profile creator has been granted access to
the [HiddenDesign] role in the Integra database’s ACL. Users with this role will see design
elements which are hidden in the source Notes database.

Reader and Editor Access to individual profiles can be set at the level of individual profiles.
Utilize Notes’ standard ACL tools to set the correct ACL rights to the Integra database.

QRsave This role governs the ability of an end-user to use the Save option in the Quick Reports to
save their reports in the Integra database.
RuntimeEdit This role governs the ability of an end-user to edit an Integra profile or a Quick Report

from the Profile dialog box. If allocated, this role will result in the presentation of the Edit
button to the user in the dialog box.

NoQuickReports When allocated to a user, group pr other entity in the ACL of the Integra database, the
effected users are unable to utilize the Integra Quick Reports product. This would ensure
that users are contained in their ability to report from Notes applications only to the
predefined reports.

Mappings Users allocated this role will be able to create field maps in the Integra database.
Filters Users allocated this role will be able to create Stored Filters in the Integra database.
Integra — Installation & Configuration Manual —V4.7/1.0 6
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Remember that user roles only function on Notes databases which are stored locally
(i.e. not on a Domino server) when the “Enforce a consistent Access Control List across
all replicas of this database” property is set on the database’s ACL.

If you intend to run either Scheduled Profiles or provide
access to running Integra profiles through a web browser
you must ensure that the Domino server on which the

integra

notes

Run perzonal agents: r
Integra database will run has the correct execution a=
control settings. The server must have the rights to Fun resticted |
execute restricted agents. Set this security feature within LotusSecnptd)ava agents:
the Security tab of the Server document in the Domino Run unrestricted A |
directory where there are a set of options related to LotusScript/)ava agents:

Agent Restrictions as shown alongside.

35 Open the Integra Database

At this point you can open the Integra database. This will result in you being presented with the About this
Database document.

|+ About Integra - Design - 18M Lotus Notes =" X
File Edit View Create Actions Tools Window Help
0y |4 Home x |E1TFYNNY Integra - Design  x
F@2U-9@svddt= ARB O IRaO 18y & - )
: integra T " =
i
Eﬁ for notes | Q AbOUt
- B
- =
4 =
& Integra for Notes has been developed by Shireburn Software Ltd, an IBM Business Partner and a (%]
(1] company specializing in the development and deployment of Lotus Notes and Domino based .
F lutions.
ﬁ S0l
2
m SHIREBURN e L
&
&
& Shirebum Software Ltd Tel USA; (508} 915 4805 info@shirebum.com
= Caroling Court or {650) 276 D506 www shirebum.com
Guze Cali Street
o Ta' Xbiex XEX 1425 Tel UK (020) 7153 1296 support@irtegradnotes.com
O Tel Europe:  (+356) 2131 9977 www integranotes com
L www integrareparts.com
A Fax: (+356) 2131 9528
Skype us: integradnates
=]
7] T
Eél legistration
s
= This copy of Integra for Notes is not registered. Please click on the image below to open the Using This
] Database document which will guide you through the installation and registration process.
]
i
@ R . N
& ¢ Registration
B
=k Product (s): Not available
=k License Key(s): Not Available
=L Read the License Agreement
%
» For and confi ion i i access the Using This Database [+
| =@ A Office (Network) =

At the bottom of this document is a link to the Using this Database document. Selecting this link will open the
Using this Database document which provides you with a link to each of the install tasks.

Integra — Installation & Configuration Manual - V4.7/1.0
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3.6 Enter the License Key

entry into two fields as follows:

Licensee’s Name — this is the name of your
organization. This is not validated and is used
purely for reference purposes.

License Key(s) — this field requires entry of a
valid Integra license key or keys. A license key
is required per Integra product/module and per
Notes domain in which the Integra database is
to be run.

This license key(s) would have been provided to
you in a separate email from Shireburn
Software Ltd or your chosen Integra partner
and would be contained in your Proof of
Entitlement document. We recommend that
you copy this license key from the email and
paste it into the Configuration document of the
Integra database. Shireburn Software issues
Temporary License Keys to customers on receipt

The Integra Configuration document will then be displayed.

Having allocated the [Admin] role, you are now able to access the Configuration document
of the Integra database by clicking on the Configuration button in the navigator. If the
Configuration button in the navigator is not accessible then please ensure the [Admin] role
has been allocated and if necessary exit the Integra database, press the <F5> function key to disconnect from the
security system (or <CTRL-F5> in Lotus Notes 8) and re-enter the Integra database.
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B Ointegra
o
\i |
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o
&
(2]
=]
¥}
3|
il
N

Conhguration
r

The Configuration document is divided into various tabs, the first of which is the License Tab. This tab requires

| 2| configuration

Licanse | Logging | Scheduling | Web | Smartcons | POF | More Options |
Inserting the License Key

= [Enter your N o your Geganization’s name s i Narme Buld h
Yous car et ary s o o, o reame s o mpsact o e bcerme k)

# Exlo o Kcaras by provided. nckiding breckals, commat. wisshas sec sy kay
datady P damsan name, igpiry dinte and iy Rage i

= Chok the Save busion {green sck) 1o save & ciose the Condguration documant
Licensee's Nama:
[ACME Corm

License Key(s)

TEHFAL Anm ADZ0000
£ 030000

Inplace Ediling Liconse Key

and sajae b b wsed bor any of
your P Rl oy b
avadablo Thes graseng 3t o Seansn key and conbming
o Icense agreemont

of orders which are valid for 45 days. Following receipt of payment a permanent key is then issued.
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Confirm the details in the license by clicking on the confirm tick icon. This will allow you to confirm 7
acceptance of the license agreement.
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3.7

Pre-allocate User Licenses

Integra for Notes and Integra Quick Reports are licensed on a per user basis. The details of the number of licensed
users is contained as a part of the license key for the respective products and Integra keeps track of the licensed

users of both products.

In the event that a user attempts to use either product without a user license being available, the user will be

displayed an appropriate message box.

Integra Error Message il

‘ ': The number of users you are licensed For has been exceeded. Please advise the Integra For Motes database administratar,
.

Integra supports a method of self-allocation of
licenses. On first usage of either product by a

. . EfEw Roapaag-828 P 8- & - |

user, Integra will add that user’s name to the list , S e - e
of authorized users, thus “consuming” a user " o inteara — - |
. . 7] g ; f;’ Configuration &
license. This method ensures the lowest level of (nr: A8 et
administrator intervention by fully automating this | vieanss | Loggng | Seheduieg | Web | Smarcans | POF | More Optins | . ,
process. | Inserting the License Key :

= Entory Your org nam into the Mame feld '

{Yau can erver any name you lke. the name has no moec on the oeree k)

® Enler the lcense keyls) provided, ncluding brackets. commas, shashes and any key
However, Integra also allows reservations of some R s '
or all of the available user licenses to be made to Lcense's Name

selected users. An authorized user can pre--
allocate some or all of the available licenses. To
pre-allocate the licenses, a user who has been
allocated the Admin role can open up the
Configuration document where he will be
presented with the Licenses tab.

By clicking on the Licensed Users button, the user

FrtLcDEvPePeriwEROG e

File DSt View Cradte Aesond Tet Tools Wiedew hslp

O Configuration =

TACME Corp

Licoase Koyis)

Licansed Users |

{BE: 'EEEB2034BC5379)
{FACIEF DEMIIES TIBEC A

TEIHBFA)*ACME_ANZ000
AACABELT) TACME 5020000

Inplace Ediling License Key

b uswdd kot ey of

the litanse agreement

aur datab: which you inherit the Inplace Editieg 4
availabie afer entenng atkeast one vald Integra for N Koy

Rl only be

is presented with a view of the licensed users

categorized by product. Of course, on installation this view would initially be blank. Licemeed Lsere

“irl Integra for Notes Demo -

File Edit View Create Actions Tools Window Help

| |4 Home ) Integra for Notes Demo - {User Redgi...
[ BHDEEHRO

|| | Default Sans Serif 10 b 2 &7 %=

User

a-29%2=2BRACIHERO

~

|LastAﬂx=_-35 -~

|Linked Licence Key
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3 v (BE4A1ATEEEB2034BC5379D9FATE4BFA).*/SHIREBURN. A020000
Alexia Mizzi/Shireburn

(BE4A1ATEEES2034B!

P

&@1e CHBEE B

Claude Sammut/Shireburn

Elenor Cassar/Shireburn 02/07/2007

John De Giorgio/Shireburn 21/05/2007

All Profiles Joseph Micallef/Shireburn 21/05/2007
Julienne Cachia Musu'fShireburn  21/05/2007

Word Profiles Kenneth Agius/Shireburn 26/09/2007
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The Add User and Remove User action buttons allow the user to allocate the

licenses of the product or products that are licensed on a per-user basis. On % Add User "= Remove User
clicking on the Add User button, the user is presented with a dialog box:

This allows either the manual entry of a user’s name (in the format —
John Doe/Acme) or the selection of the user from a directory using Ointegra
the drop down menu arrow. Since some organizations may have :
more than one product licensed on a per-user basis, the Product i

field allows identification of the product for which this user is to

be licensed.

In the event that Integra for Notes is licensed for the server (which =
is the usual method) and Quick Reports is licensed per-user, then
the Product field will only list the Integra Quick Reports product
from the list of available products to be licensed.

3.8 Enable Scheduled Profiles

|f you |ntend to utlllze the faCI|Ity File Edit View Create Actions Tedt Tools Window Help

available in Integra for Notes for LR © Configuration X

profiles to be executed on a IHFBSe x20RA-BE9® s 6o s N> [ld-
schedule, you will need to enable s %

Scheduled Profiles for the Integra integra —=

database. This is done through for nGtes M&z’ Conﬁguratlmf

the Schedule tab of the

Configuration document. License ] Logging i Scheduling 1 Web ] Smartlcons l PDF l More Options ]

All Profiles Enabling or Disabling Scheduled Profiles &
Word Profiles Scheduled profiles are executed by an hourly scheduled agent Once this agent
has been enabled in the Integra database, it searches the Integra database for
Excel Profiles profiles due to run. Forthe correctfunctioning ofthe scheduled profiles agent. it
needs to be friggered on the server. i
XML & Text Profiles l
® To Enable Scheduled Profiles Click Here b
Field Maps ?

To enable scheduled profiles, click
on the Scheduling tab and then
click on the Enable Scheduled
Profiles hot spot. This will trigger
the enablement of the single
schedule profiles agent in the
Integra database.

Stored Filtars . X To Disable Scheduled Profiles Click Here

Configuration

NEveeswaLoE oL TL B

i

Scheduled profiles do not require an agent to be run per scheduled profile but rather just the one Scheduled
Profiles agent.

F o Scheduled profiles in Integra can only be executed on a Domino server running on a
Microsoft Windows™ environment or a Lotus Notes client also running on Windows. If the
w operating system you use is not Windows, DO NOT ENABLE Scheduled profiles.

Due to the security settings of the Domino environment, it is important that when this agent

, is enabled, it is enabled using the Notes ID of a user or server with sufficient access rights to
run agents on the Domino server on which Integra is running and the appropriate ECL
settings for accessing the file system and that the ID has access to running restricted agents
on the Domino server.

In addition, since one of the agents deletes documents in the Integra database, the ID must
also have deletion rights in the ACL of the Integra database.

Integra - Installation & Configuration Manual - V4.7/1.0 10
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3.9 Enable Database for Web (optional)

If your Integra database is deployed on a Windows ot o oo =
based Domino server for usage by web browser users, O Contguration »
. EFSBIRLDBT-B20 2 2- *
then you will need to enable the Integra database for SEE - = -
# v
Web usage. . ritaciis = !
K e e | ## Configuration
. . = ¢
Enabling the Integra database for web usage is ° Licansa | Logging | ol web | PDF | Moea Gptns |
undertaken through the Web tab of the Configuration 5 IS Web Configuration
~ Ward Profiles
document (see screenshot). 5 o o o[
To set this configuration option you require: o| ECTTER Unn et Yo € Mo
g —— b What doss tha mean
. . BN corsgunsticn |
To have appropriate access rights to run E 8 _

Unrestricted Agents for that server

S S N Y __ S YOV N WP

To ensure that the servlet fields are set correctly.

3.9.1 Web Access Control

The process to enable the Integra database for web access requires the user who is enabling this facility to have
rights to run unrestricted agents on the server to which Integra is deployed. These rights are set in the Server
Document of the appropriate server found in the Domino Directory under the Security tab. The field is named Run
Unrestricted LotusScript/Java Agents.

3.9.2 Servlet Path

Integra’s web functionality utilizes a servlet which is deployed automatically through this web configuration tab. It
is important that the servlet is deployed to the correct directory on your server. While by default, Domino servers
utilize the /servlet directory below the default Domino path of the server, it is possible that your organization may
have modified this path from the default.

The correct path used on your server needs to be set in the Configuration document. To check which directory is
used on your Domino server for the storage of your servlets, open the Domino Directory and find the Server
Document for the server on which Integra is to be deployed for usage by web browsers.

Within the tab structure of the Server Document under Internet Protocols 2Domino Web Engine you will find a
field called Servlet URL path. Ensure that the setting in the Integra Configuration document’s web tab for the field
called Relative Domino Servlet Path is set to the same value as that in the Servlet URL path field on the Server
Document.

In addition, the Servlet URL field in the web configuration tab of the Integra Configuration Document needs to
identify the web server’s host name or IP address followed by this path. For instance, if the host name of the
server (available across the network to users of Integra) is everest.acme.com and the default /servlet directory is
used, then the Servlet URL field should be set to: everest.acme.com/servlet

As a result, the two fields on this configuration page need to be as follows:

Relative Domino Servlet path — this field identifies the directory under your default Domino data directory
which contains servlets. It is by default called /servlet but in case your organization uses a different folder to
contain servlets, this should be reflected here.

Servlet url — this field defines the complete url that points to the servlet directory. This is likely to be
something like http://everst.acme.com/servlet or http://www.acme.com/servlet.

Integra - Installation & Configuration Manual - V4.7/1.0 11
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3.9.3 Enabling web usage
Once the servlet fields are set correctly and the security is ensured, enable web configuration by clicking on the
following text “To Enable This Integra Database for Web Browsers Click Here.”
Due to the security settings of the Domino environment, it is important that when this agent is
enabled, it is enabled using the Notes ID of a user or server with sufficient access rights to run
agents on the Domino server on which Integra is running and the appropriate ECL settings for
accessing the file system and that the ID has access to running restricted agents on the Domino
server.
In addition, since one of the agents deletes documents in the Integra database, the ID must also
have deletion rights in the ACL of the Integra database.
3.10 Configure PDF Output
Integra profiles include a facility for exporting output to PDF file format. This option can be set within the profile
found within the Word or Excel tabs as well as at runtime. See the Integra Profile Creator’s Manual for more
details.
Integra supports various PDF output method including its own freely licensed Integra PDF Writer. The available
PDF options consist of the following:
Integra PDF Writer
PDF Suite 995
Adobe’s Acrobat Distiller™ client,
Acrobat PDF Writer™ client
Ommniwatch Shared Watch Folder
o You are licensed to use the free of charge Integra PDF Writer only in
A conjunction with Integra for Notes and for the number of users licensed
“ for the usage of Integra for Notes.
The PDF writing capability needs to be configured by the
administrator inside the Integra database itself before it
can be used. This is done through the Configuration page
where a tab is specifically dedicated to the PDF
configuration.
Multiple PDF options can be selected and, when Integra ;
executes the PDF creation capability on the workstation, i
Integra will check which of the configured options are . }
available on that particular machine. Ea‘ i
The Integra PDF Writer, PDF 995 and Acrobat PDF Writer < ——
are all printer based PDF solutions and require the
deployment and installation of the writer to the desktop.
Integra — Installation & Configuration Manual - V4.7/1.0 12
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3.10.1 Configuring Integra PDF Writer
The installation of the Integra PDF Writer requires three steps:

1. selection of the Integra PDF Writer as one of the required PDF options in the Configuration page.

2. orthe attachment of the Integra PDF Writer executable software into the Configuration page. This enables
easier distribution of the executable to end-users, particularly ones that might be on remote networks or
laptop users.

3. running of the Integra PDF Writer installation routine by end users on their workstations.

This installation will require a reboot of the PC.

To ease the configuration and installation task for administrators and users of the Integra PDF Writer, Integra
allows an administrator to deploy the latest executable of the Integra PDF Writer to the desktop via the Integra
configuration option of the Integra database. This facility ensures that no separate distribution of the Integra PDF
Writer software needs to be made to end users. This can be achieved by attaching the Integra PDF Writer installer
exe into the attachment field at the bottom of the PDF configuration form.

You can obtain the Integra PDF Writer software in ither of 2 [ o o e m———
ways: JE o T mw o

9
2
3
8

1. point your browser at [ 7 configuration

www.integra4notes.com/integrapdf

2. oropen the Configuration page of the Integra database
(you will require access to the Admin role in the
database’s ACL, and move into the PDF tab. Then click
on the Integra PDF Writer Downloadbutton.

AHES &R

Integra POF YWriter Download

Either of these options will take you to the appropriate |/ gumemr i - Lo o il - 2N

page on the Integra web site which contains this G 11 ntio/wwwintegradnotes com/We 4

executable and a”OWS yOU tO download |t tO a 1 BOV 8 Google Directory shreburn ) Insegradhictes Wetimil Quickr (3} Rotary Malta @ Planet Lotus 3
temporary folder of your choice. integra
01:-- nates

To download the Integra PDF software: —~-f

(

1. Rightclick on the IntegraPDFWriter.exe icon at the 4

bottom of the page. f

. . L 4

2. Select the Save Target As... Optlon. You will be Integra POF Writer Installer I

prompted to save the file to a directory of your This page contains the instaber for tha Integra POF Whiter. J

choice. Save the IntegraPDFWriter.exe file in any gebtieliiousit ¥

. . 1. Right click on the IntegraPDFWnter.axe icon below.
temporary directory on your workstation. NN ol W _f
3, You will be prompted to save the file to a drectory of your choice, Save th
Do IntegraPDFWilter exe fle m any temporary directory on your workstabion P
Once the download has been effected, open the | 4;;;__:’ i AR 2 g s Yo e sasagie geen e o™

Configuration document inside your Integra database,
open the PDF tab and attach the IntegraPDWriterF.exe file into the Rich Text field in the Integra PDF (Client) tab.

Once this is done, the installation on workstations can proceed.

Integra - Installation & Configuration Manual - V4.7/1.0 13
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3.10.1.1 Installing the Integra PDF Writer on the Workstation

Once the Integra PDF Writer software has been il Integra for Notes - (Excel Profilesiby Category) - IBM Lotus Notes
attached into the Configuration page, end-users  |Fie Edi Yiew Crasts  Actions Tools Window Help I
will be able to install the software on their | |4 Hom | ghministration__ Pl

. . . ‘Workstation Options 3 Install Integra SmartIcon
workstations. To install the Integra PDF Writer oo Prefie Tnstall Iniegra PDF Writer N

H i Preferences

on the workstatpn, open the Integra datfa\base ® @ ¢ B jettllngs... | Repai [ UpgradeFrofle Selection Foder
and then run Actions -> Workstation Options -> CZ?:“'HZE ;| 5ot To Active Integra Databass
Install Integra PDF Writer from the main Lotus - v'."’.“ﬁw}"' - — A
Notes menu.
You will be presented with a page with an Install and an Uninstall button. Install Uninstall |

Select Install and follow the installation wizard.

In the event that the user attempts to install the Integra PDF Writer without the administrator first having attached
the Integra PDF Writer installation EXE in the Integra database, the user will be provided with a warning message.

The Integra PCF Writer Installer could not be found in the Integra Configuration document

3.10.2 Configuring other PDF Writers

2
& Acrobat Distiller Properties E‘E|

In addition to the free for use Integra PDF Writer, you will notice additional S mcogpon 1 Soosy ] Doootoiee
options PDF writing options related to PDF995, Acrobat PDF Writer and

Acrobat Distiller. Click on the appropriate check box related to the option or
options available on your user’s workstations and your Domino server is osetin
scheduled generation of PDF files will be used. i

Model AdobePS Aciohat Distiller

Features

In the event that some users use for instance Acrobat Distiller and others use Colr: Yas Pape avaiable
PDF995, select both these options. At runtime, in the event that one of :t:N“ i ~
these drivers is not available on the particular workstation, then the other Spesd 400 pm

Wl” be used. M aximum resolution: 4000 dpi

([ Prining Preferences... [ Frint Test Page
In the event that a user attempts to run a profile with the PDF option set and

they have no PDF driver installed, an error message indicating this will
appear to the user and the profile will generate a Word or Excel document instead.
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3.10.3 Special Configuration of Acrobat Distiller

Integra is particularly sensitive to a specific property of the Acrobat Distiller driver which must be de-selected for
the correct operation of the PDF options in Integra. This option is the Do Not Send Fonts to Distiller option which
can be found in the Distiller printer driver’s properties.

To ensure that this property is set correctly following these steps:

Click on the Windows Start Button

Select the Printers & Faxes option. This will present you with ot oney ety | B A POF S
the list of currently installed printers and faxes on the Sorord
WO rkstatio n Conversion Settings:

"
& Acrobat Distiller Printing Preferences

Right click on the Acrobat Distiller icon and select the
Properties option. This will present you with a dialog (see

alongside) displaying the properties of the Acrobat Distiller
printer driver I View Result In Acrobat

Edit Conversion Settings.

L. . ™ Prompt for the PDF Filename
Select the Printing Preferences button and click on the Adobe =5
elete lag files for successful jobs

PDF Settings tab within this dialog box. You will presented [P A —————
with the options shown in the screenshot alongside. Ensure
that the Do not send fonts to Distiller option is deselected

Fae In the event that this property is set on a workstation or server that is running an Integra
i profile with PDF generation facilities, a specific error message will be provided to the
H user indicating that this option should be disabled.

3.11 Install Word & Excel on Domino server (optional)

If you intend utilizing the Scheduled Profile facilities of Integra, a Windows platform of Domino must be used and
Microsoft Word, Excel and a supported PDF writing capability need to be installed on the Domino server.

This installation should be undertaken while logged in as an Administrator or a Local Administrator on the server
so as to provide the correct execution rights.

Fae If your Lotus Domino server is running on operating systems which are not Windows
Nt based you will not be able to run Scheduled Integra profiles as Word, Excel and PDF
H Writer will not be able to be run.

A workaround to this limitation is to install a Lotus Notes client on a Windows
workstation and set the execution of Scheduled Profiles on this machine. This machine
will then be acting as an Integra Schedule Profiles Server.

Users of Domino running on a Windows operating system are unaffected by this.

If you intend utilizing the facility for Integra Profiles to print out on the server from a Scheduled Profile, there is a
known Microsoft bug that prohibits such printing without fixing the Windows server. Please refer to the Microsoft
report on this issue found at :

http://support.microsoft.com/default.aspx?scid=kb;EN-US:;184291
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3.12 Deploy the Integra Database

Deploy the Integra database onto the licensed server(s) within your organization that is/are to host Integra. This is
done by creating replicas of the Integra database onto the various servers. Remember that a license for Integra for
Notes is required per server.

3.13 Deploy Smarticons to Users

End-users utilizing profiles created in Integra, do not need to launch the \iil Home - IBM Lotus Notes

Integra database itself, although they require Author access rights to the EilerEdit View  Creater Actions T
database. End-users do however require access to the Integra for Notes
Smartlcon. Smartlcons are the set of icons available in the icon bar of the
Notes client (see the circled Integra icon alongside) and are not to be
confused with the Action Button bar contained in the views and forms of
Notes databases which are specific to each application. Lotus Notes uses
Toolbars as the container for the Smarticons.

To minimize the touch-costs associated with the deployment of these icons to users of . -
Integra, the product contains a facility to automatically distribute these icons out to | nteg ra.
required users as defined by the person responsible for deploying the application. for notes

:

This process is fully automated for users of. There are three ways to install the

Smartlcons for users:
All Profiles

Through the Smarticons tab contained on the Configuration document which is Word Profiles
accessible through the Configuration button in the main navigator.

E:-(cel Profiles

Through the highlighted link in the Using This Database document (Broadcast
Smartlcons).
. . . . Field Maps
Through the Actions -> Workstation Options -> Install Integra Smarticon option.
| Stored Filters i
Configuration
' .‘ The Configuration button is only available to users allocated the [Admin] role
)6( within the Integra database’s Access Control List.

i Confgquration -
Fie Edit View

BM Latus Mates
Create  Actions  Text  Tools  Windew  Help

On selection of the Configuration button
and selection of the Smarticons tab, the
user is presented with a form with two
buttons as shown in the screenshot

Bl O Configuration =

SN Wy Y= 5 .

integra
below which allow the generation of an e e | # Configuration
e_mall to broadcaSt the Smartlcon Licanse | Logging | Seheduling | Web | $marscons | PDF | Mare Options | C’

installer to users.

Smarllcon Inslallalion

Al Profiles
m From here you can b gra for Install andler Urinstall funcbon
10 salectad users Itis dnlwnmc\ via nolmal Notes mzllqr abarmatively via any othar dafaull mail client
Excel Profles inatallad on your systam
XML & Text Profiles Chek on either of the opbions below,
R /| Broadcas! Smaricon Installation
Smadicze

One of these buttons launches the
installer when the person broadcasting
the install is using Lotus Notes e-mail
while the other launches the installer
when using an alternative mail client
such as Microsoft Outlook.

Broadoasl Smarticon Installaton

M5 Ward & #.9. M5 Duloak requred

DE#SRwBREGOE S

et Ay, N i ll gt g g

These are explained in the following section.
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3.13.1 Broadcast Smartlcon Installation via Notes Mail

The Broadcast Smarticon Installation via Notes Mail action button results in the generation of a Notes
email, which can be sent to those users to whom you wish to deploy and install Integra for Notes’
capabilities at the desktop. This email automatically contains all the necessary initial explanations to the user
about Integra for Notes, to which the administrator can add their own comments, as well as two url’s, one to be
used by users Lotus Notes 5 clients and the other for users of Lotus Notes 6 and 7. The users to whom Integra is to
be deployed would be identified as the recipients of this email in the To field.

@

& CUNNEN - New Message =
p: D Eﬁﬂ (1] DSOS D (Dt sons seit @@ Ml
Defaul Sans Serié Jep b iZAPEIEENEICEABFEALF
# | sena  SendandFile. SaveasDraR DeiweryOptions.. B~ & Display~ Moo~ Q
L ™ High npartsnce [ et o ot [ Sgn [ Erenpt [ Mask Subpect Cordcartal | <]
L] n In M
2| e '
[Intrgen fex Ntra |
1] !
- .
= Forwaeded by John Dositeme on 100172008 1555
f2d
; integra f ® | Smart Icons
“ for nStes |
Your system administrator sends you this document:
% | The document prowides you with the apportunity 1o install Integea for Netes, the Lotus Notes reporting toad for Woed
i} | nd Excel.on your woekstation. This installation will create a nvw Smaricon an your Notes tooibar which wil allow
;iJ you 1o stan using all the fanctionalities of this nsporting-tood on all your Notes databases
F4 | Whnat does Integra for Notes do? Lan
& * Integra for Netes gensrates raports kom Hotes data and exports your Notes data to preformatted Word or Excel
documents.
&  Inegra for Motes makes it easy to craate [abels or mail menges
.|+ Iegea for Netes allows you to pent accurately when your |3yout really matters;
|« Ienegra for Notes provides facilitios for importing data from Excel o text fles into any Notes database,
o * and much, much mare... (laam mora)
-
25+|  Whatwill happen if | stan installing?
. The installatian process will presant you with an Imstall button and will expiain moee about the passitdities of Inegra
< | for Notes and allows you ta stan the fnal installation step. That final step vell include the installatian of the Intege
- Smarticon
B HNote: the installation process prowdes an installer as well as an uninstalier
% Notes:[C125T2E 200332858 TanlariOpeniorm
=2 nteenet

On receipt of this email by an T e R — ==

intended user, clicking on the url T e T
within the email appropriate to
their client version will open the =B 2 : Sob B LR N
. . A
installer page appropriate to the B @integra | @ smartlcons | =
Notes client version, A Foie o otk e e e o e afrd nd i ot :

s v g T 10 W Gt Tat. Sy o W nd Sl

° B N e s e iroond :_:" §O" Collate data from muhiple forms and muliple databases
This document will contain both an [ B g S g P Ummioain o s fop s e B o

; & B o ot o0 o o

Install and an Uninstall button s ey L ot Babn T w3 s o 3 e o Exta 0 oty

o step wizand m«‘mn;;cma

Ih'd Requitements Wirie Back Reports 1o & Notes database

= Ly Mo Eokabatin bt £ o s o g o esiows Wi Socooar o 330 o€  GAvach Sosbovn 34 5 e of
Clicking on the Install button M 4%, . ME 2005 3 o Vatn, A moieum of 08 tard gax - gueaced s

. . i e e o " et st wapecs ma e ainats

automatically installs the Integra " e S ey st s sty s
Smartlcon onto that user’s 5 0 U Ineara Smarticen for Hotes

@ iguee your Notes W
Smartlcon Toolbar. If the user’s =

- Install Urenstall
preferences do not anticipate o
Smartlcons being On, the user will | o TR B
need to enable Icon toolbars.
The user may also need to exit and reload the Lotus Notes client for the icon to be deployed.

Integra — Installation & Configuration Manual - V4.7/1.0 17

Shireburn Software Ltd - © 2008/9 5" January 2009




integra

for notes

= If installation cannot be undertaken by a user utilizing this method, an alternative installation method
B is available via the Actions 2 Workstation Options =2 Install Integra Smarticon menu option.
“ 'm' Integra for Notes Demao - (All Profiles) - IBM Lotus Notes

File Edit View Create [Actions] Tools Window Help

Oy i " 0 Administration 3

XL DEER

Workstation Options

<

Install Integra Smartlcon .
Mew Profile... Install Integra PDF Writer ’
Settings... Preferences

Repair / Upgrade Profile Selection Folder (?
Set To Active Integra Database N

— Tools...
s Categorize...
H . m“‘.h"_\‘ L w_\l\lfwu,‘ e ey r

F o This feature will not work in the event that the e-mail is sent with the Notes encryption facility turned
w on. Please ensure that Encryption is turned off when sending this Smartlcon install mail.

- v v ¥

In the event that these Smartlcons are being deployed out to users within an external Notes domain,
the appropriate cross-certifications must be in place to enable native Notes mail delivery.

This install procedure can be run multiple times sending the Integra icon install procedure to different users and/or
groups or even repeating an installation to an existing user in the event of some feature change in the icon’s
coding.

The Integra icon has simple coding associated with it and most of the functionality is within the centralized Integra
database. As a result, modification to available features, upgrades to new versions etc. should rarely result in any
need for reinstalling the icon on the user desktop.

This approach has been taken specifically to reduce the touch-costs associated with any modifications at the user
workstation level, even though this process is automated.

3.13.2 Integra Smarticon Install via Microsoft Outlook

This method of installation is used when an organization utilizes Microsoft Outlook as its mail client rather than
Lotus Notes. When the administrator clicks on the

Microsoft Outlook version of the Broadcast Smarticon @ Broadcast Smartlcon Installation
Installation button, the standard e-mail will be created via Default Mail CI'E"_t
within Microsoft Outlook and can be addressed to the (M3 Word & &.g. M Dutlook reguired)
intended recipients as per the Lotus Notes mail based

deployment.
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3.14 Creating an Integra Log Database (optional)

Integra allows the user or developer who is creating Integra profiles to create an Integra log database to collect
runtime information about Integra execution. The Integra log database has to be based on the standard Notes
agent log template (alog4.ntf). It can be created by the user or developer himself or by the system administrator.

.7 Configuration - -
File Edt Veew Create Acheen Ted Teoh Window Help

Access to the configuration of the Integra
Log database is found in the Integra Log | O contouion
database tab on the Configuration e

document as shown in the screen shot 'S e
f

ntegra [ & Configuration

=

or not

B

alongside.

225

License | Logging | Schedulng | Web | Smartcons | POF | Mare Options |

m Setling up an Integra Log Database
Word Profiles Integra abows the user of developer who is creating Integra profes 1o create an Inegra log
database 1o coll o expcution. The Integra log b

WML & Text Profiles » Tocreate 3 newimegra Lo Database cick bere, Note: In the File-Database-Create dialog you
Pued 1o sebect e Show Advanced Templates opton 1o get the Mates Agent Log lemplate Irted

m ® lfyou already created the integra Log Database you can select the database using the prowded

File-Opan-Craleg icon

The Integra Log Database document
contains an option to create the Integra log
database directly by selection of a hot spot.
On selection of the hot spot, the user will
be presented with the standard Lotus Notes
Create Database or New Application (in
Notes 8) dialog box. Within the dialog, tick-
mark the Show advanced templates option,
as otherwise the Agent Log template will

whbe

Database.

(Integealog nst k=]

Server

Replical.  [C12560CADCHEI00E

LLaDEseewBEUORS QL

NAsAr AN

not be listed.
New Application L2l The Integra log database must be :

Specify New Application Name and Location . .

Sever  [Loca S o] based on the Agent Log template (alog4.ntf) which is

Te  [rtegsios Moo | the standard Notes agent log template.

Fle name  [integ=Integralog nst 5] For each location of an eventual replica of the Integra
[TEE—— database, a replica or new copy of the Integra log
I~ Create full text index for searching | Adyancsd... | database has to be created, following the above

Specify Template for New Application rules.

Sever  [Local -]

Template [ @ InOutBoard - On creation of the Integra log through this process, Integra will
- 1 record the file name and location of the Integra Log database for
BB Application Library (8) recording events.
m.ﬁ\rchi\re Log (6)
B Autosave x

T T In the even.t tha.t the Integra log has Peen created independently
% Show advanced templates of Integra, i.e. directly through the File->Database->New menu
¥ Inert future design changes y option, then it is essential for the database to be configured to

be used by Integra through the selection of the database using
the file dialog icon.
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3.14.1 Enabling and Disabling the Integra Logging

To enable or disable the Integra Logging mode, select the Integra database on the workspace or open it from the
bookmarks. From the menu, select Actions -> Workstation Options->-Preferences.

Integra for Motes - User Preferences

integra

for notes

[~ Enable Logging (requires the configuration of an Integra Log databasef

ar
[~ Enable Caching for Quick Reports
Language preference for run-time messages:

Notes Preference ']

Unicode character set:

|UTF-16 - 16 bit platform native byte order encoding of ISO-10646. =]

To enable and disable logging select or deselect the Enable Logging option in the preferences dialog box.

;e As logging mode creates a message for every function executed at runtime, it has a
Wi considerable impact on Integra’s performance and should only be used for
]'J debugging and disabled after the debugging process is complete.

3.14.2 Enabling and Disabling the progress Bar

When using Integra on an on-line meeting, disabling the Progress Bar reduces the amount of traffic over the
connection. To enable or disable the Progress Bar, select the Integra database on the workspace or open it from
the bookmarks. From the menu, select Actions -> Workstation Options->-Preferences.

x|

Integra for Notes - User Preferences
f

eintegra
for notes

[~ Enable Logging (requires the configuration of an Integra Log databasef
Enable Progress Bar
[~ Enable Caching for Quick Reports

Language preference for run-time messages:
Notes Preference ']

Unicode character set:

|UTF-16 - 16 bit platform native byte order encoding of ISO-10646.  +|

To enable and disable the Progress Bar select or deselect the Enable Progress Bar option in the preferences dialog

box.
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Should you have any difficulties effecting the installation of Integra for Notes, please send an e-mail to
support@integra4dnotes.com providing as many details about your configuration and setup as possible
including:

Your version of Integra for Notes

Your operating system version of your workstation and client

Your version of Word, Excel

In the case of a PDF related support issue, the PDF generation product you are utilizing and the version

number.

Contact Details:

Shireburn Software Ltd
Carolina Court

Guze Cali Street

Ta' Xbiex MSD 14
MALTA

Tel USA:  (508) 915 4805
(650) 276 0506
Tel UK:  (020) 7193 1296

support@integra4notes.com
www.integra4notes.com
www.integrareports.com

Tel Europe: (+356) 2131 9977
Fax: (+356) 2131 9528
Skype: integra4notes.

Useful web links:

www.integra4dnotes.com

www.integra4dnotes.com//faq

www.integra4dnotes.com/manuals

www.integra4dnotes.com/demo

integra

for notes

support@integra4notes.com
www.integra4notes.com
Tel USA: (508) 915 4805 or (650) 276 0506
Tel UK: (020) 7193 1296
Tel Europe: +356 2131 9977
Fax +356 2131 9528
Time Zone CET (Paris, Berlin, Rome)
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